
WinJammer Help Index

WinJammer is a Windows program which is used to manipulate MIDI data.    It allows you to record and 
playback songs, send and receive MIDI data, and edit the MIDI events.    It stores all songs using the 
standard MIDI file format, so it can share files with many other MIDI software packages, including 
software for other machines.

WinJammer is not a free program, but is being distributed under the Shareware concept.    This allows 
you to test the program to determine whether it is worth anything, and then buy it if you are going to use 
it.    You must register the program if you are going to use it.    See the help topic Registration for 
registration instructions.

WinJammer is also under continuing development.    If something doesn't work correctly or behaves 
strangely, please let me know.    I am also always open to suggestions for improvements to WinJammer.

This index contains a list of all Help topics available for WinJammer. For information on how to use Help, 
press F1 or choose Using Help from the Help menu.

Quick Start Quick start up help for first time users.
Commands Information on a particular command.
Procedures Answers to "How do I..." questions.
Keys List of various keys used in WinJammer.
Registration How to Register WinJammer



Quick Start

Welcome to WinJammer.    We will try to get you up and running as fast as possible by describing how to 
play one of the sample songs.

Configuration

Before you can play a song the MIDI hardware must be configured.    The MIDI Configure command is 
used to do this.

Playing a Song

Let's start by playing one of the sample songs packaged with WinJammer.    Two steps are required to 
load and play the song.

1. Load the song.    Select the File Open command through the menu, Ctrl+O key or by clicking on the 
icon shown on the left.    Using the dialog box displayed, select one of the sample songs and press Ok.    
The song will be loaded into memory, and the main window will be updated to show a list of the tracks in 
the song.

2. Play the song.    This part is easy, simply click on the Play icon or press either the Spacebar or the P 
key.    For more information check out Playing for how-to information.

Adjusting the Song

The sample songs that come with WinJammer are voiced according to the General MIDI Specification.    
This means they should play properly through the MIDI Mapper, assuming that you have set up a 
mapping for your equipment.    If you want to change the MIDI channels and patches used in a song, it is 
fairly easy to do, as you will see below.

1. Switch back to the main window.    If there are any pop-up windows on top of the main window, they 
can be closed by selecting them and using their system menu to close the window.    For more information 
see Closing Windows.

2. Select the track to modify.    The main window makes it easy to determine what changes you need to 
make, because the patch number and MIDI channel are displayed for each track.    Select the track you 
want to modify by clicking on it with the mouse or moving the select bar using the up/down cursor keys.    
See Selecting a Track for more information.

3. Change the MIDI channel.    The channel number can be changed temporarily using the Track 
Information command, or permanently using the Track Change Channel command.    Choose Change 
Channel from the Track menu, and complete the dialog.    This will then change the channel number of all 
MIDI events in the track to the entered value.

4. Change the Patch.    The patch number is changed using the Track List window.    This window is 
opened using the F2 key, clicking on its icon as shown on the left, or by selecting it off the Window menu. 



Edit the program change event by double clicking on it with the mouse or selecting the event and 
pressing Enter.    You can then either select another track from the main window, or close the Track List 
window by pressing F2 again.

You can now play the song, using the procedure listed above.    You should probably also save your 
changes to the songs (use the File Save command).



Commands

This index contains a list of the Help available on the various WinJammer Commands.    For information 
on how to use Help, press F1 or choose Using Help from the Help menu.

File Menu Create, Load or Save files.
Edit Menu Copy, Move or Delete tracks in the song.
Track Menu Perform changes on whole tracks.
MIDI Menu Control MIDI devices.
Song Menu Edit Song Parameters
Window Menu Control the windows.
Options Menu Customize WinJammer.



Procedures

This index contains a list of the Help available on the various WinJammer Procedures.    For information 
on how to use Help, press F1 or choose Using Help from the Help menu.

Copying a Track How to copy the contents of a track.
Deleting a Track How to delete a track.
Moving a Track Moving a track in the song.
Exiting Returning to Windows.
Recording Recording a track.
Playing How to play the song.
Selecting a Track How to select a track.
Switching Windows How to switch between active windows.
Opening Windows Starting one of the windows.
Closing Windows Destroying one of the windows.
Selecting Events How to select an event to edit.
Using the Toolbar Use of the Toolbar.
Saving Type 0 Files Creating a MIDI Format 0 file.



Windows Keys

The following keys may be used as short cuts for various commands in the main menu.    These keys are 
active in all windows, except when the song is playing or recording.

F1 Help
F2 Open or Close the Track List window
F3 Open or Close the Piano Roll window
F4 Open or Close the Play Controls window
Ctrl+O Open a new song
Ctrl+S Save the current song
Ctrl+A Save the song after asking for a file name
Ctrl+R Send Reset sequence to all MIDI devices
F6 Switch to the next window
Shift+F6 Switch to the previous window

The following sets of keys are only supported on some windows.    They are grouped by window.

Main Window

Bksp Undo the previous track change
Shift+Del Move track into the paste buffer
Ctrl+Ins Copy the track into the paste buffer
Shift+Ins Insert the contents of the paste buffer
Del Delete the track from the song
Spacebar Start or Stop Play
P Start play
R Start recording
F Move to the end of the song
W Move to the start of the song
S Stop playing or recording
T Adjust the current tempo
B Adjust the starting position for playback
M Mute the current track

Track List & Piano Roll Windows

Enter Edit the current event
Del Delete the current event
Ins Insert a new event
D Change the note's duration
R Insert a rest before current note
C Make current note part of a Chord
1 Turn current note into a whole note
2 Turn current note into a half note
3 Turn current note into a quarter note
4 Turn current note into a eighth note
5 Turn current note into a sixteenth note
6 Turn current note into a thirty-second note
7 Turn current note into a sixty-fourth note
Spacebar Start or Stop Play

Piano Roll Window Only



PgUp Move the current note up one octave
PgDn Move the current note down one octave
Up Move the current note up one semitone
Down Move the current note down one semitone
Tab Move to the next note in the track
Shift+Tab Move to the previous note in the track



Registration

As discussed in the index, WinJammer is being distributed as Shareware.    This allows you to evaluate 
the program to see if it performs properly, before you have to pay for it.    It does not allow you to 
"evaluate" the program forever - if you use it after evaluating it for a week or two, then you must register.

To register WinJammer send me a note and a cheque or money order for $50 US.    Please include in 
your note your name, mailing address, current version number and computer/MIDI setup.    The current 
version information is found in the Help About dialog box.    If you would like a copy mailed to you, please 
add an additional $5, and I will send you the most recent version available.    Please note that registration 
for WinJammer includes registration for WinJammer Player.

I will send your registration keys, which you can then use with the File Register command to unlock the 
program.    If you have a CompuServe account, I will send the registration keys immediately via 
CompuServe mail, otherwise I will have to send you an old fashioned letter.

I can be reached at:
Dan McKee
69 Rancliffe Road
Oakville, Ontario
Canada
L6H 1B1

Please ensure that you use the correct postage.    It currently costs 40 cents to mail a letter from the US to 
Canada.    I know a number of people have had their letters returned because of insufficient postage.

Software Excitement!

The good folks at Software Excitement! will also accept registrations for WinJammer.    They accept 
Visa/Mastercard, and will accept international orders.    If you want a copy of the program sent to you, they 
can also do this for a nominal charge.

Software Excitement! can be reached a number of ways.    If you are a member of CompuServe, they 
have a store in the "Electronic Mall" (GO SE) that you can use for free.    They will also take orders via 
normal mail, phone or fax at:

Software Excitement! (Attn: Registrations)
6475 Crater Lake Highway
Central Point, OR 97502

Toll Free Phone: (800)444-5457
Fax Number: (503)826-8090
Non-Toll Free: (503)826-8082

MIDILIB.DLL

A substantial amount of the effort that went into WinJammer was actually spent developing MIDILIB.DLL - 
the code that actually runs the MPU-401.    If you are trying to develop a Windows program that uses a 
MIDI device, I may be able to help you out.

I am selling a developer's kit so that you can write your own Windows based MIDI programs.    This kit 
includes: printed documentation for the library, the needed include/library files, some example programs 
with source, a registered copy of WinJammer and limited distribution rights for MIDILIB.DLL.    The price 
for the kit is $100 US, and any registration fees paid for WinJammer are deductible from this price.

You will be able to distribute your programs through Shareware channels as long as you make a 



registered copy of your program available to me.    I will advertise your product with all of the Shareware 
MIDI programs that I produce.    You will have to acknowledge me as the author of MIDILIB.DLL, and 
place certain information in your program's About box.

If you are interested in distributing MIDILIB.DLL in a commercial product, a separate negotiated license is 
required.    Please give me a call to discuss this.    If necessary, I will customize a DLL for you.

The*Drums

The first Shareware product using MIDILIB.DLL written by someone other than me has recently been 
released.    This is a great program called The*Drums, written by Fabio Marzocca.    Fabio's description of 
his program is:

The*Drums V3.50 for Microsoft Windows!    Universal Editor/Sequencer for drum parts.    Build 
your own drum patterns and songs, and save them as Standard Midi File Format.

Check it out!

Support (How to contact me)

There are a number of channels that you can use to contact me.    My CompuServe id is 70742,2052.    A 
message there will reach me if sent via mail or if left in the MIDIFORUM.    I can also be reached on 
Internet as 70742.2052@compuserve.com.

I monitor the MIDI conferences on SmartNet, Rime, NorthAmeriNet, Intelec, and Interlink.    Address 
messages it to me to be sure I see it.

I can be reached by telephone at (416)844-1821.    Please try to call between the hours of 7 and 9 PM, 
Eastern Time.    If all else fails, you can always write me at the address above.



Spacebar

The Spacebar can be used to start and stop playback from the Track List, Piano Roll or Main window.

If a song is currently playing, pressing the Spacebar will cause it to stop.    If nothing is playing, the 
Spacebar will cause play to start.    For more information, see the topic Playing.



Mute

The current track can be muted at any time by pressing the M key.    This is often very useful when 
recording, or while voicing a song.

The Track Information command can also be used to mute a track.



File Menu

The File menu includes commands that enable you to load or save files, or create a new song.

For more information about a File Menu command, select one of the following topics.

New Create a new song.
Open Loads a song file.
Save Saves the current song.
Save As Saves the song under a new name.
Merge Merges a song into current song.
Import Import a Adlib ROL file.
Exit Exits WinJammer.
Register Registers your copy of WinJammer.



Edit Menu

The Edit menu includes commands that enable you to copy, delete and move tracks within the song.

For more information about an Edit Menu command, select one of the following topics.

Undo Restores the previous contents of a track.
Cut Deletes track, and moves it to the paste buffer.
Copy Copies track to the paste buffer.
Paste Moves track from the paste buffer into the song.
Clear Clears a track of all events.
Delete Deletes a track.



Track Menu

The track menu includes a number of commands which perform global changes to an entire track.

For more information about a Track Menu command, select one of the following topics.

Change Channel Change the MIDI channel of events in a track.
Clear Section Delete events in a time range.
Filter Events Delete selected MIDI event types.
Filter Channel Delete MIDI events on some channels.
Information Edit track parameters, display track information.
Merge Merge events from two tracks into one.
Quantise Adjust timing of events.
Replicate Copy a section of a track.
Split Split a track into multiple tracks.
Transpose Transpose the notes in a track.
Transform Perform transformation on event values.



MIDI Menu

The MIDI menu includes items that control the way WinJammer responds to various MIDI events.

For more information about a MIDI Menu command, select one of the following topics.

Thru Determines whether MIDI events are echoed.
Pitch Wheel Determines whether continuous controller events are recorded.
Exclusive Determines whether System Exclusive events are recorded.
Real Time Determines whether MIDI Real Time messages are ignored.
Send Real Time Determines whether MIDI Start/Stops are sent.
Send MIDI Clocks Determines whether MIDI Clocks are sent.
Internal Clock Timing source is internal.
MIDI Clock Timing source is from MIDI clock events.
System Exclusive Send and Receive MIDI System Exclusive data.
Sys Ex Customize Customize System Exclusive request strings.
Reset Sends MIDI reset sequence on all channels.
Auto Reset Automatically send MIDI reset sequence on stop.
Metronome Configures the Metronome.
Configure Configures the MIDI Device.



Song Menu

The Song menu is used to edit and set some options that effect the entire song.

For more information about a Song Menu command, select one of the following topics.

Timebase Sets the time base for a new song.
Song Key Sets the key signature for the song.



Window Menu

The Window menu controls which windows are displayed.

WinJammer contains three pop-up windows in addition to the main window.    The main window is the only 
window active when WinJammer is started, and shows a list of the tracks in the song.    It's used to select 
a track.    The main window also contains the toolbar, which is used to control playback and recording.

The Track List and Piano Roll windows are used to display or edit the events in a single track.    The Track 
List window displays the events in a text format, while the Piano Roll window displays MIDI Note events in 
a format similar to standard musical notation.

The Play Controls window is used to control the metronome and the patches used in a song.

For more information about one of the WinJammer windows, select one of the following topics.

Track List Display or Edit MIDI Events in list format.
Piano Roll Display or Edit Note Events in Piano Roll format.
Play Controls Control the Patches and Metronome.

The Windows Menu is used to open or close one of the three WinJammer windows.    If a check mark is 
shown beside the window's name, then selecting that window will cause it to be closed.    If no check mark 
is shown, the window will be opened.

For further information about how to open and close the windows, select one of the following topics.

Switching Windows How to switch between active windows.
Opening Windows Starting one of the windows.
Closing Windows Destroying one of the windows.



Options Menu

The Options Menu occurs in three windows: Track List, Piano Roll and the main window.    In each 
window, the menu contains a different set of options.

Most of these options are stored when you exit WinJammer so that next time you use WinJammer you do 
not have to customize WinJammer again.

For more information about one of the Options Menu commands, select one of the following topics.

ROL Pitch Wheel Enable MIDI Pitch Wheel events in ROL files.
ROL Save Patches Save instrument mapping in ROL files.
Preferences Set preferences for WinJammer.
Relative Control the interpretation of time changes.
Velocity Display or hide the velocity scale.
Dashed Lines Display or hide dashed staff lines.
Clef Switches Display selected clef staff lines.
Sound Event Sound events as they are selected.



Copying a Track

In order to duplicate the contents of a track, the following steps must be performed.

1. Select the track you would like to copy by selecting it in the main window.    See Selecting a Track for 
more information.

2. Perform an Edit Copy command (key: Ctrl+Ins) to copy the track into the paste buffer.

3. Select the location to insert the new copy of the track.    This is done by selecting the track that the new 
track should be inserted before.

4. Perform an Edit Paste command (key: Shift+Ins) to insert the track into the song.

If another copy of the track is desired, repeat steps 3 and 4.

If you only want to copy a section of a track, see the Track Replicate command.



Deleting a Track

In order to delete a track perform the following steps.

1. Select the track you would like to delete.    See Selecting a Track for more information.

2. Perform an Edit Delete command (key: Del) to delete the track from the song.



Moving a Track

In order to move a track to another position in the song, perform the following steps.

1. Select the track you would like to move.    See Selecting a Track for more information.

2. Perform an Edit Cut command (key: Shift+Del) to delete the track and place it into the paste buffer.

3. Select the location to insert the track, remembering that the track will be inserted before the selected 
track.

4. Perform an Edit Paste command (key: Shift+Ins) to insert the track back into the song.



Exiting

To exit WinJammer and return to Windows, choose either Close from the main window's system menu or 
Exit from the File menu.    You can also close WinJammer by pressing the Alt+F4 key combination.

If you have not saved your last set of changes, WinJammer will ask you if you want to save them before 
exiting.



Recording

The following steps are required to record a track.

1. Select the track in the song to record into.    If the track chosen is not empty, the recorded track will 
replace it in the song.

2. Press the Record button to start recording.

3. Press the Stop button when recording is finished.

If you inadvertently record over a track which you did not want to loose, the Edit Undo command (key: 
Alt+Bksp) will restore the original track.    If you also want to keep your recorded track, use the Edit Copy 
(key: Ctrl+Ins) or Edit Cut command (key: Shift+Del) to copy the recorded track into the paste buffer 
before restoring the original track.

MIDI Clock and Real Time switches.

If you are recording from another MIDI Sequencer or computer, then the Real Time and MIDI Clock 
switches may prove to be useful.    The MIDI Clock switch specifies that the tempo is to be taken from the 
remote MIDI device, rather than using the internal clock.    The Real Time switch allows the remove device 
to start and stop the recording.    For more information, see the MIDI Real Time Switch and the MIDI Clock 
Switch.



Playing

A song is played using the toolbar on the main window.

Play is started by pressing the Play button, or pressing P.    Play can also be started by using the 
Spacebar in the Piano Roll, Track List or Main windows.

While the song is running, window is updated to show the elapsed time in seconds and the current beat 
number.    As tempo changes or patch changes are encountered, these are also displayed.

The tempo of the song can be changed while it's playing using the tempo scroll bar.    There may appear 
to be a lag when changing the tempo.



Selecting a Track

The current track is used in the two edit windows, and all of the commands in the Track menu.    To 
change the current track, perform the following steps.

Using the Keyboard

1. Switch to the main window by pressing F6 one or more times.

2. Use the cursor Up/Down keys to change the selected track.

Using the Mouse

1. Switch to the desired track by clicking on it in the main window.

See Switching Windows for more information on how to switch to the main window.



Switching Windows

With the multiple windows approach used by WinJammer, a method of rapidly switching between active 
windows is needed.

Using a Mouse

To switch to another window using the mouse, simply click somewhere on the window you wish to switch 
to.    If the window is not active, you can start it using the Window menu of the main window.

You can also switch windows by clicking on an icon on the toolbar.    These icons open the window if it is 
closed, close the window if it is the active window and switch to the window if it is not the active window.

Using the Keyboard

Two keys have been provided which will cycle through the active windows.    The F6 key switches to the 
next window, while the Shift+F6 key will switch to the previous window.    The order of the windows is: 
Notes List, Piano Roll, Play Controls and Main Window.

The window menu (or short cut key) may also be used to switch control.    These commands open the 
window if it is closed, close the window if it is the active window and switch to the window if it is not the 
active window.



Opening and Closing Windows

The various windows are opened and closed in three ways.    You can use the Window menu of the main 
window, various short cut keys or the icons on the toolbar.

Using the Mouse

Use the mouse to execute the correct command from the Window menu of the main window.    If the 
window is closed, it will be opened.    If it's open and the active window, it will be closed.    If it's open and 
not the active window, it will be made the active window.

You can also click on the appropriate icon on the toolbar.    This performs the same way as is described 
above.    The various icons on the toolbar are listed below along with the short cut keys.

Using the Keyboard

Each window has been assigned a function key which is used to open, close or switch to the window.    
The short cut keys are listed below.

F2 Track List Window

F3 Piano Roll Window

F4 Play Controls Window



Selecting an Event

To edit or delete an event from a track, you must first select it in either the Track List window or Piano Roll 
window.    This can be done with either the keyboard or the mouse.

Track List Window

This window behaves like a normal Windows list box.    Select an event by clicking on it with the mouse, or 
using the cursor keys to move your selection.    The event can then be edited by double clicking or using 
the Enter key.    The event can be deleted using the Del key.

Piano Roll Window

To select a note in this window with the mouse, simply click on the desired note.    With the keyboard, use 
the Tab/Shift+Tab keys to move to the next or previous note.    The note can be edited by double clicking 
or using the Enter key.    The event can be deleted using the Del key.



Using the Toolbar

If you have a mouse, the toolbar is a handy short cut to using the menus, just as short cut keys provide 
abbreviation for keyboard users.    In order to use the toolbar you must have a mouse.    The various 
controls on the toolbar are described below.

Track Name

The currently selected track's name and number is shown in the "combo-box" on the left side of the 
toolbar.    You can select a new track using this instead of the list box in the main window.    Clicking on the 
down arrow on the right side of the track name will cause a list box to appear.    You can then scroll this 
list, and select the desired track by clicking on it.

File Open & File Save

This icon is used as a short cut for the File Open command, which is used to load a song from disk.

This icon is a quick way of saving the current song.    It is identical to the File Save command.

Track Information

The Track Information command is used to edit global information about a track or to view additional 
information about a track.

Track List, Piano Roll and Play Controls

The next three icons start up, shut down and switch to any one of the three pop-up windows that are used 
for track editing and playing.

This icon is used to start up, switch to or close down the Track List window.    This window is used to edit a 
track's data in a list format.

The Piano Roll window is started, switched to or closed down with this icon.    It is used to edit a track's 
note data in a format similar to standard musical notation.

The Play Controls window is used to control patches and the metronome, and can be started, switched to 
or closed down by clicking on this icon.

Help



This icon is used to start up the help system that you are presently using to view this with.    It is 
equivalent to the Help Index menu item or the F1 key.

Record & Play

This icon is used to start recording on the current track.    This is equivalent to pressing the R key on the 
main window.    See the Recording topic for more information.

This icon starts playing the song.    This can also be done using the P key on the main window, or by 
pressing the Spacebar.    See the Playing topic for more information.

Rewind & Fast Forward

This icon rewinds the current song position back to the last position that playing started or back to the 
start of the song.    This can also be done using the W key on the main window, or through the use of the 
Beat scroll bar on the toolbar.

This icon fast forwards the current song position to the last place that playing started or the end of the 
song.    This can also be done using the F key on the main window, or through the use of the Beat scroll 
bar on the toolbar.

Stop

This icon stops the current playback or recording.    Playback will automatically stop at the end of the 
song, but recording normally needs to be stopped manually.    The S key can also be used to stop play.

Beat

The current beat number is displayed while playing or recording.    Whenever play is started, it is started at 
the current beat number.    The scroll bar can be used to change the starting point as well.    The B key 
can be used to move the focus to the scroll bar, or the mouse can be used to move the scroll position.    
The rewind and fast forward buttons are also used to control the starting position for playback.

Tempo

The current tempo is displayed as a number of beats per minute and on the scroll bar.    When playing, all 
tempo changes are reflected here.    The T key can be used to move to the tempo scroll bar.    The tempo 
can be changed while the song is playing using the scroll bar.



Saving Type 0 Files

In order for a song to be saved as a type 0 file, there must be only one track in the song.    If there is only 
one track in the song, WinJammer will save the file as a type zero file.

Follow the following steps to create a type 0 file.

1. Merge all of the tracks in the song into a single track in track number zero.    This can be easily done 
using the Track Merge command.

2. Delete all tracks other than track number zero.    This is done by pressing highlighting the track to 
delete and pressing the Del key.    See the Edit Delete command for more details.

3. Save the song using the File Save or File Save As command.



File New Command

The File New command is used to clear the current song from memory.    It deletes all tracks, and 
reinitializes the system to its start up state.

If you have not saved the last changes you made to the current file, WinJammer will ask you if you would 
like to save them before clearing the song.

After clearing the song from memory, before any recording is done, you should always set an initial tempo 
and time signature in track zero.    See Track List Window and Recording for details.

Short Cut Key: Ctrl+N



File Open Command

The File Open command is used to load a song from disk.    It replaces the current song in memory.

If you have not saved the last changes you made to the current file, WinJammer ask you if you would like 
to save your changes before loading the new song.

This command will load standard MIDI files from a number of sequencers as well as files saved from 
WinJammer.    For more details on the supported files, see MIDI File Format.

Short Cut Key: Ctrl+O



File Save Command

The File Save command saves the current song using the current file name.    If there is no current file 
name, the File Save command is the same as the File Save As command.    If a song was previously 
named using the File Save As command or if the file was loaded using the File Open command, then the 
file on disk is overwritten by the song.

Files created by WinJammer can be loaded by many other MIDI software packages.    For information on 
the file format used, see MIDI File Format.

Files are saved as MIDI format 1 files unless only one track exists in the song.    When only one track is in 
the song, the file is saved as a format 0 file instead.    See Saving Type 0 Files for more details on how to 
create a type 0 file.

Short Cut Key: Ctrl+S



File Save As Command

The File Save As command saves the current song, after prompting for a file name.    If the entered file 
name exists, WinJammer will prompt before overwriting the file.

Files created by WinJammer can be loaded by many other MIDI software packages.    For information on 
the file format used, see MIDI File Format

Files are saved as MIDI format 1 files unless only one track exists in the song.    When only one track is in 
the song, the file is saved as a format 0 file instead.    See Saving Type 0 Files for more details on how to 
create a type 0 file.

Short Cut Key: Ctrl+A



File Merge Command

The File Merge command is used to load a song into memory without losing the contents of memory.    
This can be used to merge two songs together.

Each track from the merged file is added as a new track.    If the timebase of the merged song is different 
from the current song in memory, the merged song's timebase is adjusted to match.    This means that you 
should make sure that the current song's timebase is reasonable before performing the merge.    Use the 
Song Timebase command to do this.

Once the song has been merged into memory, you should edit and/or merge the tempo and time 
signature events into track zero using the Track Merge command.

The song key of the merged file is ignored.    The two songs are not adjusted to make sure they are in the 
same key signature.    You will have to do this yourself, using the Track Transpose command.



File Import Command

The File Import command is used to import an Adlib ROL file into memory.    A dialog box is displayed 
allowing you to select the file to load.    Once a file is selected, the ROL file is read into memory.

A second dialog box is displayed after the song has been loaded.    Using this dialog box, you can select 
appropriate MIDI patch numbers to match the instruments in the ROL file.    Once you assign patch 
numbers to all ROL instruments, all of the patch numbers will be added to the converted file.    If the ROL 
Save Patches switch is on, the patch assignments will be saved for the next time you wish to import a file.

After the import operation is complete, track zero will contain time signature and tempo change events 
only.    The track name of this track will be the same as the ROL file name.

Each track converted will be named after the first instrument found in the track.    The second instrument 
found will be used as the instrument name.    The output track is monophonic, and is assigned to channel 
one.    The only possible events that will be produced are note events, pitch wheel changes and patch 
changes.    The production of pitch wheel changes is controlled by the ROL Pitch Wheel switch on the 
options menu.    Since the track volume commands from the ROL file are translated into velocity, you may 
need to adjust the velocity scale of the tracks using the Track Transform command.    Finally, you should 
assign appropriate channels to the tracks using the Track Change Channel command.



File Exit Command

The File Exit command will terminate WinJammer, and return to Windows.    If the last changes to the 
current file have not been saved, WinJammer will ask if you would like to save them before exiting.



File Register Command

The File Register command is used to register your copy of WinJammer.    Once registered, the reminder 
dialog will no longer appear.    The track name field will also be able to be entered and saved, and the 
About box will display the registration information.

To register the program, you must carefully enter the registration information.    Please take care to enter 
the three fields exactly as I sent them to you, or the registration will fail.

For more information on registration, including the cost and how to do it, see the Registration topic.



Edit Undo Command

The Edit Undo command is used to undo the previous operation on a track.

All commands which cause a track to be changed will copy the original track into the undo buffer before 
making any changes.

The Edit Undo command will switch the contents of the undo buffer and the original track.    A second Edit 
Undo command will undo the previous undo.

Short Cut Key: Alt+Backspace



Edit Cut Command

The Edit Cut command copies the contents of the current track into the paste buffer.    The previous 
contents of the paste buffer are lost.    The track is then removed from the song.

This command can not be reversed using the Edit Undo command, however the Edit Paste command can 
be used to insert the track back into the song.

Short Cut Key: Shift+Delete



Edit Copy Command

The Edit Copy command copies the contents of the current track into the paste buffer.    The previous 
contents of the paste buffer are lost.

This command can not be reversed.

Short Cut Key: Ctrl+Insert



Edit Paste Command

The Edit Paste command inserts the contents of the paste buffer into the song before the current track.    
All tracks from the current track to the last track are shifted down to make room for the new track.

A track is placed into the paste buffer using either the Edit Copy or Edit Cut commands.

Short Cut Key: Shift+Insert



Edit Clear Command

The Edit Clear command will clear the contents of the track.    It removes all events from the track.    The 
original track is not available for an Edit Paste operation, however it can be recovered using the Edit 
Undo command.



Edit Delete Command

The Edit Delete command will delete the contents of the track, without copying the track into the paste 
buffer.    The deleted track is not available for an Edit Paste operation, however it can be recovered using 
the Edit Undo command.

Short Cut Key: Del



Track Change Channel Command

The Change Channel command will change the channel number of selected events in a track.

A dialog box is displayed prompting for a channel range and the new channel number.    All MIDI events in 
the track which have a channel number in the entered range will have their channel number set to the 
new value.

For example, assume there were two events in the track:
1:000 Note On 3 C 5 64 0:059
2:000 Note On 4 E 6 64 0:119

If a change channel command were carried out, selecting a range of 4 to 16, with a new channel of 1, the 
following would result:

1:000 Note On 3 C 5 64 0:059
2:000 Note On 1 E 6 64 0:119

In the event that you make a mistake performing this command, the Edit Undo command can be used to 
restore the track.



Track Clear Section Command

The Clear Section command is used to delete all events in a range from a track.

A dialog box is displayed, allowing the entry of the start and ending times.    These times are inclusive, 
that is if a starting time of 1:000 is specified then an event with a time of 1:000 will be deleted.    This 
command will not effect any events outside of the specified time range.    Events starting after the end of 
the range will not have their starting times changed.

In the event that you make a mistake performing this command, the Edit Undo command can be used to 
restore the track.



Track Filter Events Command

The Filter Events command is used to delete certain MIDI events from a track.

A dialog box is displayed, which is used to select which event types are to be deleted from the track.    
Selecting an event causes an "x" to be displayed in the check box, which will cause any events of this 
type to be deleted from the track.

In the event that you make a mistake performing this command, the Edit Undo command can be used to 
restore the track.



Track Filter Channel Command

The Filter Channel command is used to delete all MIDI events in a channel range from a track.

A dialog box is displayed, which is used to select the range of channel numbers to delete.    All events with 
a channel number in the specified range will be deleted.

Non MIDI events such as tempo and time signature events will never be deleted.

In the event that you make a mistake performing this command, the Edit Undo command can be used to 
restore the track to its original value.



Track Information Command

The Track Information command is used to edit global information about a track, as well as display useful 
track information.

The following is a list of the fields that can be modified using this command.

Track Name is the name that is assigned to the track.    It's displayed in the main window, used to identify 
the track in dialog boxes and saved in the file.

Instrument is the name of the type of instrument used in the track.    It's displayed in the main window 
and saved in the file.

Force to Channel is used to force all events in the track to be output on a single MIDI channel.    The 
forced channel is not saved in the file when the song is saved.    The Track Change Channel command 
can be used to make permanent changes to the track's channel.

Mute Track is used to mute a track during playback.    The muted status of a track is not saved.

Velocity Adjust by is a quantity to be added to the velocity of all MIDI Note On events.    This is often 
used to control the volume of the notes.    Negative adjustments are supported by simply entering a 
negative value.    Velocity adjustments are not saved, however the Track Transform command can be 
used to perform a permanent velocity adjustment.

Semitones to Transpose is used to transpose the track during playback.    Negative transpose amounts 
can also be used.    The transpose amount is not saved.    See the Track Transpose command for a 
permanent transpose command.

Information Displayed

If all events in the track occur on the same MIDI channel, that channel number is displayed.    If more than 
one channel is used, the message "MIDI Events on Multiple Channels" is displayed instead.    If there are 
no MIDI events in the track, the message "No MIDI Events" is displayed.

The total track time length is displayed, along with the number of events in the track and the number of 
bytes required to hold the track.

The maximum number of simultaneous notes that are on at any given time is displayed.    If only one note 
is on at a time, the message is "Monophonic Track".    If no note events are found in the track the 
message will be "No Notes in Track".

The range of note events is displayed.    This is often useful when converting drum tracks between 
different drum machines.    The note range is shown by both note name and decimal MIDI note number.    
The octave number displayed can be adjusted using the Options Preferences command.

If a MIDI Program Change event occurs in the track, the selected patch number will be displayed.    If 
multiple patches are used, a message will indicate this as well.    The patch base can be adjusted using 
the Options Preferences command.



Track Merge Command

The Track Merge command is used to combine the contents of two tracks into one.    All events from both 
tracks are placed into the destination track, in the appropriate order.

Since only the destination track is changed, the Edit Undo command will restore the previous contents of 
the destination track.



Track Quantise Command

The Track Quantise command is used to globally alter the timing of all events in a track.

The starting time for all events in the track will be adjusted so that they start on a time which is an even 
multiple of the entered time.

The note lengths can also be quantised if desired.    The three possible actions that can be performed on 
the note lengths are:

Unaffected do not adjust any note lengths
Aligned quantise note lengths
Equal set all lengths to the quantisation time

In the event that you make a mistake performing this command, the Edit Undo command can be used to 
restore the track to its original value.

For example, assume that the track contained the following:
0:118 Note On 3 C 5 64 0:073
1:112 Note On 3 E 6 65 1:010
2:049 Note On 3 F 5 40 0:080

Quantisation with lengths Unaffected and a Time Interval of 60 (eighth note) will produce:
1:000 Note On 3 C 5 64 0:073
2:000 Note On 3 E 6 65 1:010
2:060 Note On 3 F 5 40 0:080

With lengths Aligned, result would be:
1:000 Note On 3 C 5 64 0:059
2:000 Note On 3 E 6 65 0:119
2:060 Note On 3 F 5 40 0:059

With lengths Equal, resulting track is:
0:118 Note On 3 C 5 64 0:059
1:112 Note On 3 E 6 65 0:059
2:049 Note On 3 F 5 40 0:059



Track Replicate Command

The Replicate command is used to make one or more copies of a section of a track.

A dialog box is displayed, which is used to select a range to copy from, a starting time for the first copy 
and the number of times to copy the section.

All events in the source range are copied.    The times specified are inclusive, that is if an event starts at 
one of the boundary times then it will be included in the copy.

The starting time entered is the time that the "from" time is mapped to.    When more than one copy of the 
section is made, the starting time for the new copy is the previous starting time plus the length of the 
source range.

For example, suppose the original track contained the following:
1:000 Note On 3 C 5 64 0:073
2:000 Note On 3 E 6 65 1:010
2:060 Note On 3 F 5 40 0:080

If a copy was made with source from 2:00 to 3:00, with a starting time of 4:00 and two copies are made, 
then the following track will result:

1:000 Note On 3 C 5 64 0:073
2:000 Note On 3 E 6 65 1:010
2:060 Note On 3 F 5 40 0:080
4:000 Note On 3 E 6 65 1:010
4:060 Note On 3 F 5 40 0:080
5:000 Note On 3 E 6 65 1:010
5:060 Note On 3 F 5 40 0:080

In the event that you make a mistake performing this command, the Edit Undo command can be used to 
restore the track.



Track Split Command

The Track Split command is used to split a track into one or more tracks.    There are four different ways 
that a track can be split.

Channel: specifies that each output track should only contain events on one MIDI channel.    If the source 
track also contains non-MIDI events such as a tempo change, an additional track will be created for these 
non-MIDI events.

Event: each different event type will be split into a separate track.    For instance a track containing note 
events and program changes would be split into two tracks.

Individual Note: each output track will only contain one note's events.    This would primarily be used 
when converting a song from one drum machine to another.    This will in general create a large number of 
tracks.

At: performs a split at a specified note.    The source track will be split into two tracks.

Since only the source track is changed, the Edit Undo command will only restore the previous contents of 
it.    The split tracks must then be manually deleted.



Track Transpose Command

The Track Transpose command is used to transpose all note events in the track.    There are two types of 
transpositions supported.

A Normal Transposition is performed by adding a number of semitones to each note.    This corresponds 
to a change in the key signature of the track.    To transpose up one octave, you must transpose 12 
semitones.    To transpose down one octave, use -12 instead.

In Key transposition is a special type of transposition, where the track is moved up or down without 
changing the key of the track.    For example if a standard C scale is moved up one tone, you get a C 
scale from D to D.

When performing an In Key transposition, you must enter the current key of the song and the number of 
tones to transpose.    A transposition of 7 tones is equivalent to a normal transpose of one octave.

Suggestion: A song written in a major key can be converted into a minor key by performing an In Key 
transpose of -2 tones, followed by a normal transpose of 3 semitones.

The Track Information command can be used to temporarily transpose a track for playback.

In the event that you make a mistake performing this command, the Edit Undo command can be used to 
restore the track to its original value.



Track Transform Command

The Track Transform command is used to transform all events in a track according to the formula:
new = ( ( old + add ) * mult ) / div

In other words, the original data has an amount added to it (which may be negative).    The result is 
multiplied by a number, and this result is divided by another amount.    The resulting value is range 
checked to ensure it is valid, and this result becomes the new value.

The event data to be transformed can be any of the following: Note Velocity, Key Pressure, Control 
Change, Channel Pressure, Pitch Wheel, Song Tempo, Event Start Time or Note Length.

This command can do some very powerful things to your data, such as: adjusting the velocity of a track, 
evenly adjusting the tempo of a song, quantising events etc.

Consider the following problem.    You have a track which has velocities between 0 and 127 which you 
want to adjust into the range 0 to 100.    You could adjust these by adding -27 (multiply by 1, divide by 1), 
which would probably make some notes too soft.    A better way would be to add zero, multiply by 100 and 
divide by 127.    This will evenly re-map the velocities.

A similar process can be used to adjust a song's tempo.    If there are a few tempo events, you might find 
it easier to edit them.    If there are a large number of tempo events, and you want to speed up the tempo 
by 5% as an example, then add zero, multiply by 105 and divide by 100.



MIDI Thru Switch

This switch determines whether MIDI events received are echoed.    If this switch is on (checked), all MIDI 
events received by the MIDI hardware are echoed to all output devices.    This effectively changes the 
MIDI Out ports into MIDI Thru ports.

MIDI Thru mode is only active during recording and playback.    System Exclusive messages are never 
echoed.



MIDI Pitch Wheel Switch

This switch determines whether MIDI continuous controller information is recorded.    If the switch is on 
(checked), MIDI continuous events will be recorded.    Otherwise these events are ignored.    The following 
table shows the effect that this switch has on each event type:

Event Type On Off
0x8n Note Off recorded recorded
0x9n Note On recorded recorded
0xAn Key Pres recorded ignored
0xBn Ctrl Chg, 0-63 recorded ignored
0xBn Ctrl Chg, 64-95 recorded recorded
0xCn Pgm Chg recorded recorded
0xDn ChnlPres recorded ignored
0xEn PitchWhl recorded ignored

This switch only operates when recording.    The MIDI continuous controller events are always sent during 
playback if they are found in a track.



MIDI Exclusive Switch

This switch will be implemented in a future release.



MIDI Real Time Switch

This switch determines whether WinJammer responds to or ignores MIDI real time messages: Start 
(0xFA), Stop (0xFC) and Continue (0xFB).

If the switch is on, a MIDI Stop will cause playing or recording to stop.

If the switch is on, a MIDI Start or MIDI Continue will cause recording or playback to start.    Otherwise a 
Start or Continue message is ignored.    WinJammer makes no distinction between Start and Continue.

If this switch is on, starting play or record will set WinJammer up for the operation, but not actually start it. 
The Toolbar will show "Waiting..." instead of a beat number.    When the MIDI Start or Continue is 
received, this will change to the normal beat counter.    If a MIDI Stop is then received, play or record will 
stop.

In order to use this switch, you must have a MIDI input device.



MIDI Send Real Time Switch

This switch controls whether or not MIDI Start/Stop/Continue messages are sent.

If this switch is on, a MIDI Start or MIDI Continue message will be sent when playback or recording is 
started, and a MIDI Stop message is send when stopping.    A Start message is sent if playback starts at 
the beginning of the song, otherwise a Continue message is used.



MIDI Send MIDI Clock Switch

This switch controls whether or not MIDI Clock messages are sent.

If this switch is on, MIDI Clock messages are sent during playback or recording.    MIDI Clocks are used to 
synchronize with external devices during playback.



MIDI Internal Clock Switch

This switch is used when the source of all timing events is internal to the MIDI controller.    Normally this 
switch should be on.

When Internal clocking is used, the MIDI processor on the interface card generates its own tempo events. 
This means that the song's tempo is determined by the tempo commands contained in the song.

The other currently supported clock source is described in MIDI Clock.



MIDI Clock Switch

This switch is used when an external MIDI device is to be used as the "master".    This external master 
device must send MIDI clock events 24 times per beat.    This is used to control the tempo of all 
recordings and playbacks.

When MIDI Clocking is used, any tempo events in the song are ignored.    The tempo bar in the Toolbar 
window is also ignored.

Under normal circumstances the Internal Clock should be used.



MIDI System Exclusive Command

This command is used to send and receive bulk MIDI data.    Normally this would be MIDI System 
Exclusive messages.

The dialog box displayed will allow you to load and save files from disk, move data into and out of the 
clipboard and send or receive data from the MIDI device.    Each of these operations is described here.

Receiving data from a MIDI Device

The combo-box and Receive button are used to receive data from an attached MIDI device.    The request 
string currently shown in the combo-box is transmitted, and the program records everything it receives.    
The number of bytes received is displayed while recording.    To stop recording, press the Stop button.    
The request strings can be customized using the Sys Ex Customize command.

Sending data to a MIDI Device

The Send button causes the current contents of the buffer to be transmitted.    A delay is inserted between 
MIDI System Exclusive messages, which can be adjusted using the Sys Ex Customize command.

Loading and Saving Data

The Load button is used to load a file into the buffer.    The Save button is used to save the current 
contents of the buffer in a file.    These files are in a standard format, normally known as MIDIEX.    This 
type of file contains raw MIDI data, without any headers or other information.    This format is widely used, 
which allows files to be readily shared.

Filtering the Buffer

The Filter button causes the current contents of the buffer to be examined and all data other than MIDI 
System Exclusive data to be deleted.    This would normally be done after recording a bulk dump.

Clipboard Support

The Copy and Paste buttons are used to exchange data with other programs through the Windows 
clipboard.    The Copy button causes the current contents of the buffer to be converted into readable 
ASCII, and placed into the clipboard as a text file.    This can then be edited by a program such as 
Notepad.    The Paste button performs the reverse, the contents of the clipboard are converted back into 
raw data, and placed into the clipboard.

The input accepted by Paste may contain comments and blank lines as required to make the file more 
understandable by humans.    The format used is compatible with the old format accepted by the old MIDI 
Send Hex command from the previous versions.    The following is an example of a valid file.

;
; The following will set the master volume of a MT32 to 100
; Comments are from a semicolon to the end of the line
;

; Blanks, Tabs and New Lines are ignored
; UPPER and lower case are allowed in hex numbers

F0 41 10 16 12 10 00 16 64 76 F7



; the following repeats the previous command

f0 4110161210 0 166476 f7



MIDI Sys Ex Customize Command

This command is used customize the settings used in the System Exclusive command.    This includes the 
various dump request commands, the default MIDIEX file extension and the delay between system 
exclusive commands when transmitting.

Although the request strings were intended to be used to request dumps from MIDI devices, any string 
that you wish to send can be entered here.    For example, you may wish to include a reset command 
which you occasionally need to send.

Whenever this command is executed and there are no request strings stored, the strings will be reloaded 
from the executable file.

Help!

I would like to expand the default request strings beyond the current MT-32 strings, but I need your help 
to do this.    If you have some request strings which you would like to see included in a future release of 
WinJammer I would be happy to add them.    Just send them to me and you'll see them next time around.



MIDI Reset Command

This command causes a MIDI reset sequence to be transmitted on all channels.    The reset sequence is 
as follows:

Bx 7B 00 ;all notes all
Bx 01 00 ;modulation wheel to zero
Bx 07 7F ;volume to max (127)
Bx 40 00 ;sustain pedal off
Ex 00 40 ;centre pitch wheel

Short Cut Key: Ctrl+R



MIDI Auto Reset Switch

This switch causes a MIDI reset sequence to be transmitted on all channels when playback is stopped.    
The reset sequence is as follows:

Bx 7B 00 ;all notes all
Bx 01 00 ;modulation wheel to zero
Bx 07 7F ;volume to max (127)
Bx 40 00 ;sustain pedal off
Ex 00 40 ;centre pitch wheel



MIDI Metronome Command

This command is used to customize the MIDI metronome for your equipment.

The dialog box displayed allows you to select two notes to be used for the metronome.    It also allows you 
to turn the metronome on or off.

In Accented mode two notes are used for the metronome.    The note labeled "First Note" is sent as the 
first beat in a measure, while the other note is sent for the remaining beats in the measure.

In On mode the single note in the "Other Beats" box is sent on each beat.

The Record Only switch is used to turn the metronome off during playback.    When this switch is on, the 
metronome will only be heard while recording.

The Metronome can also be controlled on the Play Controls window.



MIDI Configure Command

This command is used to configure WinJammer for the hardware on your particular machine.    You must 
do this before you can play or record.

The dialog box displayed is used to select the devices to be used.    The list of available devices will 
depend on the drivers you have installed.    Simply select the desired input and output devices, then press 
Ok.    It is possible to reconfigure WinJammer whenever you choose.

Control Panel

The Windows Control Panel application is used to configure Windows for your equipment.    There are two 
steps required to set up MIDI devices.

1. Install the drivers: The first step is to install drivers for your hardware.    This is done through the Drivers 
icon in the Control Panel.    When first started, you will be presented with a list of the installed drivers.    
Press the Add button to add more drivers to the list.    Depending on the driver, you may be asked for the 
hardware configuration information.    Once all of the drivers are added, you will have to restart Windows 
to make the new drivers available.

2. Configure the MIDI Mapper: The MIDI Mapper is a special MIDI output device that is used to remap 
songs from the General MIDI Specification to whatever equipment you have.    You can start the MIDI 
Mapper by clicking on the icon in the Control Panel.    The dialog shown will allow you to select your setup 
from one of the defaults.    If you get a message saying that the current setup references a device that you 
don't have installed, then you'll have to either edit the configuration or choose a different one.    See your 
Windows manual for more details.

WinJammer MIDI Configuration

Now that the proper devices are installed, you can use the MIDI Configure command in WinJammer to 
select the appropriate input and output device.    Note that the MIDI Mapper is sometimes slow - you'll 
notice this in particular when editing a track with the Sound Event switch turned on.

If you are simply playing songs, there is no need to specify an input device.    Some operations such as 
the MIDI Real Time switch require an input device however.



Song Timebase Command

This command sets the number of "ticks per beat" used in a song.    This effects the resolution of a song's 
timing.    In standard time (4/4), the number of ticks per beat is the number assigned to a quarter note.

The song's timebase can be set or changed at any time.    When the timebase is changed, all events are 
adjusted to conform to the new timebase.    A note that was a quarter note before will start at the same 
time, and still be a quarter note.

When a ROL file is imported, or when you load a file from another sequencer, you may get an error 
message when you try to play the song saying that the timebase is invalid.    If this occurs, simply adjust 
the timebase to one of the values listed in the Song Timebase dialog box.    If in doubt as to what to 
choose, try 120.



Song Key Command

The Song Key command is used to specify the current song's key signature.    Currently only a single key 
signature can be used for a song, although it can be changed anytime.

The key signature is used to determine the name of each note in the Track List window.    It is also used to 
determine the colour and placement of the note on the staff in the Piano Roll window.

For example, if the key signature was G (one sharp), then the names of any accidentals would be 
changed to reflect a sharp rather than a flat (C# instead of Db).    In the Piano Roll window, an F# would 
now be displayed as a normal note in gray rather than a note in gray.

This command has no effect on anything other than how the notes are displayed.    Changing the key 
signature will not cause and tracks to be automatically transposed.



Track List Window

This window is used to edit the contents of the current track.    The track events are displayed in a list 
format, so all events in the track can be edited and viewed in this window.

Events are selected in the track list window by moving the select bar to the desired event.    The list can 
be scrolled using the scroll bar or normal Windows scrolling keys.

There are various commands available when using the Track List window.    These are fully explained in 
the following topics.

Event Menu Used to insert/delete/edit single MIDI events
Options Menu Customize WinJammer.

The following topics will help to describe how to perform various tasks in the Track List window.

Switching Windows How to switch between active windows.
Opening Windows Starting one of the windows.
Closing Windows Destroying one of the windows.
Selecting Events How to select an event to edit.

Track List Abbreviations

In the track list screen different abbreviations are used to depict the various event types.    The following is 
a list of the abbreviations used and where appropriate, their MIDI status byte.

Tempo set of new tempo for song
TimeSig change in time signature

Note On MIDI Note On event: 0x9n
KeyPres MIDI Key Pressure (Key After Touch): 0xAn
CtrlChg MIDI Control Change: 0xBn
Pgm Chg MIDI Program (patch) Change: 0xCn
CnlPres MIDI Channel Pressure (After Touch): 0xDn
PtchWhl MIDI Pitch Wheel (Bender): 0xEn



Piano Roll Window

This window is used to display and edit the contents of the current track.    The track's note events are 
displayed in a graphical format, similar to both standard musical notation and "piano roll" notation.

Each note event is shown in a standard musical staff as a rectangle.    The vertical position of the 
rectangle is the correct location on the staff, depending on the Song Key.    The note's starting time 
determines the start of the rectangle, and the width of the rectangle is determined by the length of the 
note.    Accidentals (sharps and flats) are shown in a second colour.

The screen can be scrolled horizontally using either the scroll bar or the cursor keys.    If some notes are 
not being displayed because the window is too small, the window can be resized so that they may be 
seen.

There are various commands available when using the Track List window.    These are fully explained in 
the following topics.

Event Menu Used to insert/delete/edit single MIDI events
Options Menu Customize WinJammer.

The following topics will help to describe how to perform various tasks in the Track List window.

Switching Windows How to switch between active windows.
Opening Windows Starting one of the windows.
Closing Windows Destroying one of the windows.
Selecting Events How to select an event to edit.



Play Controls Window

The Play Controls Window is used to control a song while it is playing.    It consists of two groups of 
controls, each of which is used to control different aspects of the playback.

Metronome

The controls contained in the Metronome box are used to control the metronome and the count-in at the 
start of the playback.    The buttons are used to turn the metronome off, on or on with accents at the start 
of each measure.    The number of beats of initial delay is entered as the count in amount.

The metronome is only active while playing or recording.    If the Record Only switch is checked, the 
metronome will only be heard when recording.

The MIDI Metronome command is used to customize the notes used to sound the metronome.

Patches

The patches section is used to display the last patch (MIDI program change) sent on each MIDI channel. 
Every time a patch is sent on a channel, the screen is updated.

If you would like to experiment with different patches while the song is being played, you can edit the 
patch number for any MIDI channel.    Simply input the new patch number, and it's sent out the correct 
channel.

You can also change the patch number for any channel when the song is not playing, because any patch 
number entered is immediately sent.

The Lock Patches switch controls whether the patches contained in the song are to be sent.    If this 
switch is on, then the patches in the song are filtered from the tracks as the song is played.    This allows 
you to easily fiddle with the patches for the song without having to edit the individual tracks.



Event Menu

The Event Menu on the Track List and Piano Roll windows is used to edit, insert and delete events in a 
track.    It contains the following commands.

Edit Edit the currently selected event.
Insert Insert a new event into the track.
Delete Delete the currently selected event.
Duration Change the length of the note and adjust next note.
Rest Add rest before current event.
Chord Create a chord with two events.
Search Search for an event type.
Next Search for the next event of the selected type.
Previous Search for the previous event of the selected type.
Dotted Make dotted notes.
Triplet Make triplets.
1 Turn current note into a whole note.
2 Turn current note into a half note.
3 Turn current note into a quarter note.
4 Turn current note into a eighth note.
5 Turn current note into a sixteenth note.
6 Turn current note into a thirty-second note.
7 Turn current note into a sixty-fourth note.



Event Edit Command

This command is used to edit the currently selected event.

A dialog box will be displayed containing the current event.    Any changes can then be made to the event. 
Whenever a change is made, it is validated, and if the entered value is illegal then a valid value is 
substituted.

When entering a note name, use either the + or # keys for a sharp, and either - or b for a flat.

The middle C octave number and patch base can be set using the Options Preferences command.    The 
current setting of the Options Relative switch will also effect the way a change in time is handled.

Short Cut Key: Enter or Double Click



Event Insert Command

This command is used to insert a new event into a track.

A dialog box is displayed asking what type of event you want to insert.    Once you have selected an event 
type, a second dialog box is displayed to allow entry of the event.    This second dialog box will be filled in 
with as much information as is possible from the currently selected event.

There is no requirement to insert events in sequence in the track as WinJammer will automatically find the 
appropriate location in the track for your new event.

When entering a note name, use either the + or # keys for a sharp, and either - or b for a flat.

The middle C octave number and patch base can be set using the Options Preferences command.

Short Cut Key: Ins



Event Delete Command

This command is used to delete the currently selected event from the track.

While is it not possible to undo an event that was deleted by accident, you can undo all of your changes 
to the track by closing the Track List or Piano Roll window, then selecting Edit Undo from the main menu.

Short Cut Key: Del



Event Duration Command

This command is used to adjust the length of the current note, and the start time of all subsequent events.

A dialog box is displayed asking for the duration of the current note.    Enter the note's desired length in 
ticks, depending on the current Timebase, which is displayed for you.    The length of the note will be set 
to one tick less than the entered time, and the start time of all events following it in the track will be 
adjusted to the entered time.

For example, assume that the current timebase was 120, and the track contained the following:
0:118 Note On 3 C 5 64 0:073
1:112 Note On 3 E 6 65 1:010
2:049 Note On 3 F 5 40 0:080

If a duration command was performed on the first event, setting the duration to 1:000 (one beat), the 
result would be:

0:118 Note On 3 C 5 64 0:119
1:118 Note On 3 E 6 65 1:010
2:055 Note On 3 F 5 40 0:080

Short Cut Key: D

There are also short cut keys for some of the common duration commands.    These are:

Dotted Make dotted notes
Triplet Make triplets
1 Turn current note into a whole note
2 Turn current note into a half note
3 Turn current note into a quarter note
4 Turn current note into a eighth note
5 Turn current note into a sixteenth note
6 Turn current note into a thirty-second note
7 Turn current note into a sixty-fourth note



Event Rest Command

This command is used to add time to the current start time of the current event.

A dialog box is displayed asking for the length of the rest.    Enter the desired rest length in ticks, 
depending on the current Timebase, which is displayed for you.    The amount entered will be added to the 
start time of the current event, and all subsequent events in the track.

For example, assume that the current timebase was 120, and the track contained the following:
0:118 Note On 3 C 5 64 0:119
1:118 Note On 3 E 6 65 1:010
2:055 Note On 3 F 5 40 0:080

If a rest command was performed on the first event, entering a value of 0:2, the result would be:
1:000 Note On 3 C 5 64 0:119
2:000 Note On 3 E 6 65 1:010
2:057 Note On 3 F 5 40 0:080

Short Cut Key: R



Event Chord Command

This command is used to adjust the start time of the current event to be the same as the start time of the 
previous event, thus creating a chord.

If this command is executed on the first event in a track, the start time of the event is set to zero.

For example, assume that the current timebase was 120, and the track contained the following:
1:000 Note On 3 C 5 64 0:119
2:000 Note On 3 E 6 65 1:010
2:057 Note On 3 F 5 40 0:080

If a rest command was performed on the first event the result would be:
0:000 Note On 3 C 5 64 0:119
1:000 Note On 3 E 6 65 1:010
1:057 Note On 3 F 5 40 0:080

Short Cut Key: C



Event Search Command

This command is used to search for an event type in the current track.    When the command is used, a 
dialog box is displayed asking for the event type to search for.    The track will then be searched for the 
next event of the selected type.

The Next and Previous commands can be used to quickly search for the next or previous occurrence of 
the event.

Short Cut Key: S



Event Next Command

This command is used to search for the next occurrence of an event in the current track.    The event type 
to search for is selected through the Search command.    This command will search forward in the current 
track looking for an event of the correct type.    If one is found, then the track is positioned at the event.

Short Cut Key: N



Event Previous Command

This command is used to search for the previous occurrence of an event in the current track.    The event 
type to search for is selected through the Search command.    This command will search backward in the 
current track looking for an event of the correct type.    If one is found, then the track is positioned at the 
event.

Short Cut Key: P



Event Dotted Switch

This switch modifies the current quick duration commands so that the durations that they specify are 
increased by half.    If this switch is on, a quick duration of a Half Note is equal to three beats instead of 
two.

If this switch is on and the Triplet switch is also on, then the quick duration commands are normal.    This 
is because the Triplet switch decreases the duration by 2/3 and the Dotted switch increases the duration 
by 1 1/2.

Short Cut Key: .



Event Triplet Switch

This switch modifies the quick duration commands so that the durations that they specify are decreased. 
If this switch is on, three notes will fit in the time that two notes would have fit in before.

If this switch is on and the Dotted switch is also on, then the quick duration commands are normal.    This 
is because the Triplet switch decreases the duration by 2/3 and the Dotted switch increases the duration 
by 1 1/2.

Short Cut Key: T



Event Whole Note Command

This command is a quick way of specifying a Duration of 4 times the current Timebase for the currently 
selected note.    In 4/4 time, this would equal one whole note.

Short Cut Key: 1



Event Half Note Command

This command is a quick way of specifying a Duration of two times the current Timebase for the currently 
selected note.    In 4/4 time, this would equal one half note.

Short Cut Key: 2



Event Quarter Note Command

This command is a quick way of specifying a Duration equal to the current Timebase for the currently 
selected note.    In 4/4 time, this would equal one quarter note.

Short Cut Key: 3



Event Eighth Note Command

This command is a quick way of specifying a Duration of half the current Timebase for the currently 
selected note.    In 4/4 time, this would equal one eighth note.

Short Cut Key: 4



Event Sixteenth Note Command

This command is a quick way of specifying a Duration of one quarter of the current Timebase for the 
currently selected note.    This is normally equal to one sixteenth note.

Short Cut Key: 5



Event Thirty-second Note Command

This command is a quick way of specifying a Duration of one eighth of the current Timebase for the 
currently selected note.    This is normally a one thirty-second note.

Short Cut Key: 6



Event Sixty-fourth Note Command

This command is a quick way of specifying a Duration of one sixteenth of the current Timebase for the 
currently selected note.    This is normally a one sixty-fourth note.

Short Cut Key: 7



Options ROL Pitch Wheel Switch

The Options ROL Pitch Wheel switch is used to determine whether MIDI Pitch Wheel events are to be 
generated when importing a ROL file.

If this switch is on (checked), then Pitch Wheel events will be generated when a ROL file is imported with 
the File Import command.    All ROL files contain pitch wheel events, which if translated often cause the 
resulting MIDI file to sound "off".    Under normal circumstances, it is probably best to turn this switch off.    
If you wish to remove pitch wheel events after the file has been imported, the Track Filter Events 
command can do this.



Options ROL Save Patches Switch

The Options ROL Save Patches switch controls whether the patch re-mapping specified when importing a 
file will be saved in the INI file.

When a ROL file is imported with the File Import command, a dialog box is displayed which allows you to 
specify MIDI patch numbers for each of the instruments in the original ROL file.    If this switch is on 
(checked), then when Ok is pressed to apply this re-mapping, then the assignments you have made will 
be kept for next time.    Over time, this will make importing ROL files easier, since the proper assignment 
of patches is already known.



Options Preferences Command

The Options Preferences Command is used to customized WinJammer to your machine and preferences. 
The following changes can be made.

Patch Base controls the first patch number used by your MIDI instrument.    This only effects the way 
patch numbers are displayed and entered.    Some companies such as Roland and Yamaha number their 
patches from 1 through 128, while other manufactures number patches from 0 through 127.    Default is 1.

Middle C Octave controls the octave number assigned to middle C.    Again different manufactures have 
chosen to use different notation, so WinJammer allows you to choose which ever octave is better for you. 
For example Yamaha uses C3 for middle C, while Roland uses C4.    Default is C5.

Note Width controls the number of beats that can be fitted onto one maximized Piano Roll window.    A 
higher number will show more beats on the screen, although each note will be narrower.    Default is 16.

Note Height controls the height of a note in the Piano Roll window.    This is actually the number of pixels 
used to draw the note's rectangle on the screen, and must be an odd number.    Default is 5.    A value of 5 
is suggested for a VGA screen.

Velocity Scale is an amount used to divide a note's velocity by to determine the height of the line to 
display.    A scale amount of 1 will cause the velocity area of the Piano Roll screen to be larger than it 
would be with a scale of 4.    Default is 4.



Options Relative Switch

This switch controls the interpretation of a change in an event's starting time when the Edit Event 
command is used.

If the switch is off, a change in the start time of an event will cause the event to be moved to a new 
location in the track.

If the switch is on, WinJammer moves this event to the new starting time, and shifts all events following it 
in the track as well.    If the new time entered is before the start time of the previous event in the track, the 
time is considered to be invalid, and no change is made.

With the switch on, it's very easy to insert a rest into a track, or perform a bit of manual quantizing.



Options Velocity Switch

This switch determines whether the velocity of each note is shown in the Piano Roll window.

If the switch is on, each note will cause a vertical line to be displayed showing a graphic representation of 
the note's velocity.    The longer the line, the higher the velocity.    For reference purposes, a horizontal line 
is drawn representing the height of a velocity of 64.



Options Dashed Lines Switch

This switch determines whether or not dashed lines are drawn in the Piano Roll Screen.

If on, dashed lines are drawn wherever a line would normally go.    For example, if the Alto Clef is not 
displayed and dashed lines are on, Middle C would have a dashed line drawn through it.

Dashed lines are intended to help locate a note that is off the normal staff lines.



Options Clef Switches

WinJammer will display three different types of clefs in the Piano Roll screen.

Most piano music uses a "grand" clef, which includes a treble and bass clef.    Guitar music, "fakebooks" 
etc often only contain a treble clef.    Some orchestral instruments such as a Viola use the Alto clef, which 
has Middle C as its middle line.

You can select which clefs you would like to see in the Piano Roll screen.    Regardless of the clef chosen, 
middle C is always located in the centre of the screen.    If an Alto clef is chosen, neither a Treble or Bass 
clef can be shown as they would overlap.



Options Sound Event

This switch is used to determine whether WinJammer should play each note as it is selected in either the 
Track List or Piano Roll windows.

If this switch is on, as each event is selected in the Track List or Piano Roll windows, the event is sent as 
well.    If the event is a note event, the length of the note will be about half a second.    If you move rapidly 
between notes, the last note will be cut off to avoid slowing your movement down.



MIDI File Format

WinJammer will read and write standard MIDI format song files.    This is a common format supported by 
most of the music programs on the market today.

WinJammer will read MIDI files, any format.    Reading a format other than 0 or 1 will cause a warning to 
be displayed, because these are the only formats WinJammer understands.    The only other currently 
defined format is type 2, which consists of multiple tracks which play one at a time.    It should be possible 
to edit a format 2 file into a valid song using WinJammer.

WinJammer can save files as either format 1 or 0.    The maximum number of tracks in the file is 64.    To 
create a format 0 file, merge all tracks into track zero and save the file.    If there are more than one tracks 
in the file, WinJammer will save it as in format 1.

All MIDI channel events are supported (status bytes from 0x80 through 0xEF).    None of the MIDI non-
channel events (status bytes from 0xF0 through 0xFF) are supported in a track.    In particular this means 
that tracks cannot contain a System Exclusive message.    Support may be added for this at a later time.    
WinJammer does support System Exclusive messages through the MIDI System Exclusive command.

WinJammer supports only a subset of the possible meta events which can occur in a file.    WinJammer is 
capable of reading files containing any meta event, however only a few are recognized (the rest are 
ignored).    The only supported meta events are:

0x03 Track Name
0x04 Instrument Name (patch name)
0x2F end of track
0x51 Tempo
0x58 Time Signature
0x59 Key Signature

All tracks containing MIDI Note Off messages (status byte 0x80 through 0x8F) will have these events 
mapped into Note On commands with a velocity of zero.    This will normally result in a smaller track 
because a new status byte does not always have to be output (MIDI running status).    Files can be further 
compressed by using a different track for each MIDI channel, and possibly using separate tracks for 
continuous events (pitch wheel, channel after touch, note pressure).

MIDI Format type 0 files contain only one track, which has all of the meta events as well as the data 
streams for each MIDI channel.    Whenever a type 0 file is loaded, it's suggested that the track should be 
split in order to form a valid type 1 file.    This will also assist in editing/voicing the song.

MIDI Format type 1 files are supposed to contain only non-note events in track 0 (tempo changes, time 
signature changes etc).    All other tracks are only supposed to contain MIDI events.    While WinJammer 
does not require this to be true, it is a good way to organize your song's tracks.    You should certainly 
follow this rule if you expect to use the saved file with any other sequences.


